A quick tutorial for using VMS

Dongsu Kim, David Mueller, Michael Winkler, and Marian Muste

September 7, 2009
# Table of Contents

1. Introduction .................................................................................................................. 4  
   1.1. Developing tools .................................................................................................. 4  
   1.2. Data requirements ............................................................................................. 4  
   1.3. Installation and launching of VMS .................................................................. 4  
2. Loading ADCP files ....................................................................................................... 6  
3. Loading GIS shapefiles ............................................................................................... 10  
4. Exporting ADCP data ................................................................................................. 14  
   4.1. Exporting entire ADCP 2D or 3D to ASCII file (.csv) ................................... 14  
   4.2. Exporting entire or selected ADCP 2D or 3D to a shape file (.shp) .......... 19  
   4.3. Exporting 3D beam locations to ASCII or shapefile .................................. 23  
   4.4. Exporting entire ADCP locations to a Google KML file (.kml) ................. 26  
5. ADCP data referencing Options ................................................................................. 28  
   5.1. Vertical referencing – water surface elevation ............................................. 28  
   5.2. Horizontal referencing .................................................................................. 34  
   5.3. Boat tracking referencing .............................................................................. 38  
   5.4. Unit ................................................................................................................ 40  
   5.5. Geo-referenced coordinate system ............................................................. 41  
6. Quality Assurance ...................................................................................................... 44  
   6.1. Error velocity filter ......................................................................................... 47  
   6.2. Beam depths filter .......................................................................................... 49  
   6.3. Boat speed filter ............................................................................................ 51  
   6.4. Summary report ............................................................................................ 51  
   6.5. Save and reload filter setup file ................................................................... 53  
7. Transect Information ................................................................................................. 54  
   7.1. Tabular view .................................................................................................... 54  
   7.2. Contour plot .................................................................................................... 58  
   7.3. Velocity profile ............................................................................................... 59  
   7.4. Ship track ....................................................................................................... 65
8. Spatial Averaging ........................................................................................................ 66

  8.1. Horizontal averaging of single group ........................................................... 67
      8.1.1. Making a group using multiple transects ........................................... 67
      8.1.2. Setup of averaging parameters and run horizontal averaging .......... 69
      8.1.3. 2D visualization of the horizontal and depth averaged velocity ....... 71
      8.1.4. 3D visualization of the horizontal velocity ........................................ 75
      8.1.5. Horizontal averaging along the single transect ............................... 78
      8.1.6. Vertical averaging of horizontal averaged velocity ......................... 79
      8.1.6. Averaging of horizontal averaged velocity ....................................... 79

  8.2. Averaging onto specified points (grids) ....................................................... 84

  8.3. Horizontal averaging of multiple groups .................................................... 87
      8.3.1. Making multiple groups ................................................................. 88
      8.3.2. Run horizontal averaging of the multiple groups ............................. 95
      8.3.3. Saving the averaged data ............................................................... 102
1. Introduction

The newly developed VMS aims at providing an efficient process for quality assurance, mapping velocity vectors for visualization and facilitating comparison with physical and numerical model results. VMS is collaboratively developed by IIHR-Hydroscience & Engineering (Dongsu Kim, Marian Muste), USGS Office of Surface Water (David Mueller), and USACE Navigation Systems Program (Michael Winkler).

VMS was designed to provide efficient and smooth work flows for processing groups of transects. The software allows the user to select group of files and subsequently to conduct statistical and graphical quality assurance on the files as a group or individually as appropriate. The software is built using Object Oriented Programming (OOP) techniques in conjunction with Borland C++ Builder (version 6). The analysis results are displayed in numerical and graphical formats. In this initial stage, VMS handles ASCII file format provided by Teledyne RD Instruments Acoustic Doppler Current Profilers (ADCP). It is anticipated that VMS will be extended to other format of input data and acoustic profilers in the near future.

This tutorial is targeted to guide beta testing of the first version of VMS.

1.1. Developing tools

Borland C++ Builder (version 6) was used as IDE for developing the graphical user interface and TeeChart version 7, which is add-on component of Borland C++ Builder, was used for the visualization and graphs.

1.2. Data requirements

Currently, VMS reads an ADCP ASCII file (**t.000 and **ASC.TXT) with configuration file (**w.000) measured by using WinRiver I, and II. Binary files acquired from WinRiver I and II are not compatible yet.

1.3. Installation and launching of VMS

The user can install VMS using the setup file (setup.exe) provided. The InstallShield Wizard will help the user to install the software. Follow each step until completion.
After installation of the software, launch the VMS by clicking the icon on the desktop.

The user can also launch the software from Windows Start menu (Start → All Programs → VMS → VMS.exe. If there were no problems during installation, the following initial interface will show up.
2. Loading ADCP files

The starting point for operating VMS is to load ADCP data. Currently, VMS should load two types of classical ADCP ASCII files from TRDI WinRiver I and II. Both files must be created by RDI WinRiver in advance. Once these files are imported, the user may begin working with the data. ADCP files can be loaded under the File menu, or by clicking the correct icon as shown below. Multiple files may also be selected at one time.
To choose multiple files, hold down the ‘Shift’ key with and click the mouse to choose consecutive files, or hold the ‘Ctrl’ key while clicking the mouse to choose non-consecutive files.
Figure 2.3. Open one or more ADCP files

Figure 2.4. Description of main interface of VMS
As an alternative to using the zoom buttons, the user can zoom in and out with the mouse. This is accomplished by left-clicking inside the chart and dragging the mouse down to the right to zoom out, or up to the left to zoom in.

If the user clicks ‘Length’ icon (the last icon in the tool pane) and drags a line by left-clicking inside the chart and dragging the mouse, the length of the line appears in the bottom of the VMS. Click this icon again to deselect this function.

The user is able to identify individual transects by clicking one or multiple files with the left mouse button, and then the corresponding transects in the map will be colored as yellow.

![Figure 2.5. Identification of individual transects](image)

In the ADCP file pane, if the user clicks the right mouse button, a popup menu will appear, which has several menus: Add more ADCP files, remove selected file, zoom to selected files,
clear selection, and so on. The save as shapefile and averaging selected files menus will be explained later in chapter 3, and 7.

Figure 2.6. Popup menu in the file pane

3. Loadinging GIS files

VMS supports loading vector-based GIS file (shapefile - *.shp) as a background for the ADCP files. Any vector formats of shape file (point, line, and polygon) are applicable. Shape files can be loaded under the File menu, or by clicking the correct icon as shown below.
Figure 3.1. Load GIS Shapefile from menu

Figure 3.2. Load GIS Shapefile from Icon
In the file selection screen, select any shape file and click open. It may take a long time load if the shape file is of a significant size.

![Shapefile selection window](image)

**Figure 3.3. Shapefile selection window**

After that, the user will see the following map that display ADCP transects with the loaded GIS file.
If the user loads multiple GIS layers and ADCP files, they can be seen in ‘Spatial Layer’ tab. The user can unload GIS or ADCP layers, select them and push ‘Delete’ key. The user is able to zoom in and out GIS and ADCP layers using icons in the right pane as seen below.

After loading a shapefile, if ADCP velocity arrows or points are below the shape file, go to the spatial layers tab and change the order of the layer. The user is able to click a layer and drag it into a place that he/she want to move. In fact, the top layer indicates the bottom layer, so move shapefile into the top layer, then ADCP velocity arrows and points will be on the top of the shapefile layer.

Figure 3.4. Loaded shape file as a background of ADCP transects
4. Exporting data

4.1. Exporting entire ADCP 2D or 3D to ASCII file (.csv)

The VMS provides functions to export 2D or 3D data of loaded transects into one single ASCII data format (CSV). 2D data will be able to contain processed velocity data in specified horizontal locations (ensembles), including depth-averaged, nearest surface, nearest bottom, or specified layer. The user is also able to export the dataset of 3D data which pertain raw bin (or cell) information from ADCP ASCII files. Figure 4.1a and 4.1c shows how to export data into ASCII format, respectively for 2D and 3D format. The user can check out the saved CSV files for 2D and 3D format using Excel, as illustrated in Figure 4.1b and 4.1d. The saved 2D or 3D files might be potentially used by the users for their additional analysis.
Figure 4.1. Exporting ADCP data into ASCII (CSV) file format: a) VMS menu to export 2D ADCP data; b) a sample of 2D ASCII file in Excel including only locations and velocity data; c) VMS menu to export 3D ADCP data; b) a sample of 3D ASCII file in Excel including all 3D information recorded in ADCP.

Before exporting ADCP data in 2D or 3D CSV format, the user is able to check out the details of them. In menu, click View Æ Data View Æ 2D or 3D as described in Figure 4.2a. According to the selection, the main interface will show a table regarding 2D or 3D data (Figure 4.2b and 4.2c).
b) 

c)
4.2. Exporting the entire or selected ADCP data to a shape file (.shp)

Under the Export tab, there is a menu enabling to save the ADCP data as a GIS shape file (see Figure 4.3). The user can either select to save the ADCP 2D Ensemble as a 2D shape file or 3D Bin data as 3D shape file as default. The geometric shape of the saved shape file is ‘Point’ for 2D shape file or ‘PointZ’ for 3D shape file. The user can open them using either ArcMap (for 2D) or ArcScene (for 3D). The exported data will include the whole loaded transects. In addition, if user committed spatial averaging (will be more discussed in chapter 8) or 3D beam location (see the details in the next chapter), the averaged results can also be exported into shape file as appeared in the main interface.
In another place, the ADCP data also can be saved as shape file. It is about saving the ‘SELECTED’ ADCP data as shape file. This function was added to handle the situation that the user requires to save only concerned transects among the whole loaded transect, after graphically select some of the transects, thus allowing the user to select only certain ADCP
ensembles for export. When ADCP transects are loaded, as described in chapter 2, the user may select individual or multiple files (or grouped files) and selected files are highlighted as yellow color. Also the user can hold ctrl when clicking on the ADCP data in the left file pane to add more of the files to the current selection. Then right click of mouse to pop-up a menu, and choose ‘Save Selected Files As *shp file’ menu as illustrated in Figure 4.5. Under the menu, the user can choose to save the ADCP 2D Ensembles as 2D shapefiles or 3D Cell data as 3D shapefiles. If the user especially selects all ADCP files in this way, all files will be saved as a shape file (then it will be same as describe in Figure 4.2). In particular, the saved 2D shape file in this way will include information with regard to original ensemble data in the selected ADCP ASCII files and addition of the depth-averaged velocities, which is different from what the user could export after using “Export→GIS files→2D Ensemble (raw) as described previously in Figure 4.2, where the user was only able to save data near surface, bottom, and specified layer (i.e., only location and velocity data).
Figure 4.5. Exporting the selected ADCP transects as GIS shapefile
4.3. Exporting 3D beam locations to ASCII or shapefile

ADCP measurements include river bathymetry information through the depth measurements acquired in individual beams for each ensemble. To obtain geographical locations for each beam contact position \((x, y, z)\), the ADCP synchronized with GPS data is subjected to the following procedures. First, the beam depth is corrected with respect to tilt (pitch and roll) recorded by the ADCP. Second, the corrected depth is transformed into geographical coordinates (herein, earth coordinates). Finally, the GPS information, recorded as UTM East/North, is added to the obtained values. VMS computes 4 or 5 geographic locations for
each ensemble, and this function is expected to help applications for bathymetry mapping. The user is able to check out and export 3D beam locations as described as Figure 4.7. The user can do this by clicking View ➔ Bathymetry Representation ➔ 4 Beam Bathymetry.

![Figure 4.7. Display the 4 beam locations for each transect](image)

The user is able to save 4 beam location as either ASCII and shape file format as described in Figure 4.8. For further usages of this information, go to Export ➔ ASCII file (*.csv) ➔ 3D Beam Location for ASCII output or Export ➔ GIS file (*.shp) ➔ 3D Beam Location for creating shape file containing those information.
Once the user saves 3D beam locations as a shape file (PointZ), the shape file can be further visualized and processed in any GIS package. Figure 4.9 shows a sample of the saved shape file (red dots) and processed bed surface based on the shape file in ArcScene (one of the ArcGIS packages) using ‘Spatial Analyst or 3D Analyst’ toolbox included in ArcGIS.
4.4. **Exporting entire ADCP locations to a Google KML file (.kml)**

VMS provides an external way to identify the 2D locations of ADCP ensembles in Google Earth data format (KML – Keyhole Markup Language). Currently, the KML file only shows the position of ADCP measurements, but further addition of more information into KML, such as velocity vector with position, is planned in the next upgrade. The following Figure 4.10 shows how to
export ADCP positions into the KML file. Click ‘Export’ in the Export menu and select the ‘Google Earth (*.kml)’ button, and finally set a name for saving.

![Figure 4.9. Export ADCP locations into Google Earth format](image)

In many cases, shape files describing the given river boundary (such as NHD Plus data used herein Figure 4.10) are not precise enough to locate positions of ADCP measurements. Thus, the user will easily complain that some of ensembles are located over the river boundary when you overlay the shape file with ADCP data. In cases that the user does not have a precise shape file, KML output from the VMS would be a good alternative way to precisely identify ADCP positions. All the user has to do is to download and install Google Earth, then open the KML output with it. If the user has Google Earth already installed, the KML file will be automatically
launched and zoomed in to the corresponding region in Google Earth, as described in Figure 4.11.

![Google Earth](image)

**Figure 4.11. A sample of the exported ADCP data in Google Earth format**

5. **ADCP data referencing options**

5.1. **Vertical referencing – water surface elevation**

VMS provides options for vertical references for the bathymetry and velocity vectors, i.e., water surface elevation. Choose ‘Water Surface Elevation’ under Options menu as shown below.
The following graphical interface will pop up. The default setting for water surface elevation of VMS is using ‘Altitude’ data from the ASCII file.
In addition, VMS provides three other options for vertical reference.

- GPS-based water-surface elevations for each transect (MSL and ellipsoid elevations).

![Graphical interface for vertical position](image)

**Figure 5.2.** Graphical interface for vertical position
If RTK data is collected, the user will have the option of using either MSL elevation or ellipsoid elevation from the GGA string. If ellipsoid elevations are selected, the user has the option to enter a custom ellipsoid separation value for the reach.

- Manually specify a water-surface elevation for each transect
Figure 5.4. Option for specifying a water-surface for each transect

The user’s inputs are able to be saved and reused. If the user selects this option, the table relating filename to water surface elevation is populated. This table is able to be stored and reloaded for use in the future.
Figure 5.5. Saving the user-populated elevation for each transect

Figure 5.6. Reloading the user-populated elevation for each transect
• Specify a fixed water-surface elevation for all transects.

Figure 5.7. Option for specifying a fixed water-surface elevation for all transects

5.2. Horizontal referencing

When ASCII file does not contain GPS data, initial positions entered by the user for the starting position of each transect can be used as a surrogate way to georeference the measurements, where bottom tracking is used to compute subsequent positions. The initial positions (latitude/longitude) are able to be entered in a table displaying all of the filenames to be processed. Once entered, the table is able to be saved and reloaded without the user having to reenter the initial positions. If initial positions are used the software provides a facility to
enter these positions or read from a file the positions for each transect to be processed. When GPS is used, a georeferenced coordinate is computed in UTM.

Figure 5.8. Multiple transect ADCP StreamPro files without having GPS information
Figure 5.9. Option for setting initial GPS reference data

Figure 5.10. Graphical interface to populate initial GPS points of multiple transects
Figure 5.11. Saving the user-populated initial GPS points for each transect

1. Click Open button
2. Load saved data
3. Click save button

User inserts Lat/Long for initial point

Save *.igps data

Loaded Lat/Long for initial point
5.3. **Boat Tracking referencing**

The user is able to select boat tracking references by either GPS or Bottom Tracking. The default setting is GPS tracking. However, the user can change it into Bottom tracking as shown below. If there is no GPS data for the ADCP dataset, there will be no difference between GPS and Bottom tracking, since GPS locations will be assigned by following bottom tracking.
Figure 5.14. Representation of the boat tracking based on GPS
Figure 5.15. Representation of the boat tracking based on Bottom tracking

5.4. Unit

The user can select either English or SI unit system to show values. It is set via the Units option under the System menu as show below.

Figure 5.16. Change unit of the software
5.5. Geo-referenced coordinate system

The geo-referenced coordinate system of VMS will default to UTM NAD (North America Datum). If a shape file is loaded first that also has a projection (.prj) file associated, the shape file's coordinate system will be used. However, upon loading an ADCP file, the ADCP data will trump the shape file's coordinate system, which ADCP files are set by default to UTM NAD. UTM zone number (e.g., 15N) will be automatically calculated. If the user loads multiple ADCP files and some of them across UTM zone, then zone number calculated from first GPS available point of first file will be forced to be zone number of others. After loading an ADCP or a shape file, the user is able to identify the current coordinate system in the bottom of the window as shown below.

![Identification of geo-referenced coordinate system](image)

Figure 5.17. Identification of geo-referenced coordinate system
Finally, there is a way to set the coordinate system, so that users are in full control. ADCP or shape file loading will never interfere if the user sets the coordinate system himself. It is set via the Coordinate System option under the System menu as shown below. This allows the user to set either UTM or Geographic coordinate systems, and affiliated zone data.

Figure 5.18. Option for changing geo-referenced coordinate system

The following interface shows up by updating current coordinate system.

Figure 5.19. Interface showing current geo-referenced coordinate system
VMS supports two UTM coordinate systems (NAD1983 and NAD1927) and Geographic Coordinate System (Lat/Long). Users are allowed to change the UTM coordinate system and zone number or select Geographic Coordinate System. If the user clicks ‘OK’, then the selected coordinate system will be applied to all ADCP and shape files currently loaded, as well as any files loaded in the future.

Figure 5.20. Changing coordinate system
6. Quality Assurance

One of major functions of VMS is to support quality assurance of the collected ADCP data. This quality assurance in VMS can be done on a transect by transect basis, and the appropriate extrapolation techniques and filter thresholds can be applied. Moreover, many of the data filters can be automated to provide a more efficient and consistent approach to quality assurance. Currently, the following filters are implemented: Error Velocity, Beam Depths, and Boat Speed.

All filters provide a graphical representation of the filter, as well as the option to apply or not apply the filter. Allowing the user to change the parameters of a filter could be possible in
the future. However, at the moment, reasonable default values are provided if the user attempts to change the parameters. The interface for quality assurance allows the user to quickly click through the transects and ensembles in a transect as necessary. The provided summary report of automated filter results would help the user determine how much manual effort will be needed to quality assure the data. Depending on the type of data being processed, discharge for each transect is provided as a quality indicator, and a table/graphic of the discharge for each transect is presented in a manner so that the user can identify irregularities.

VMS provides an additional interface for quality assurance. After loading single or multiple ADCP files, click the flag button as described in Figure 6.1 to open the QA interface.

![Figure 6.1. Button for quality assurance interface](image)

An interface named “Quality Assurance Setup” will appear as illustrated in Figure 6.2. This interface handles all loaded ADCP files (not just for the selected files), and the file names are displayed in the left file pane.
The initial interface (named ‘Discharge Info’ tab) shows discharge for each file in graphic/tabular format. If the user clicks one of files in the file pane or table (with blue color), the corresponding discharge displayed in the chart will be colored as red. The discharge table provides two discharges for each file: discharge recorded in the ASCII file (Qraw) with rectangle symbol in the chart, and computed discharge (Qfilter) with cross symbol in the chart. It does this by reflecting changes after applying filters, where the discharge calculation algorithm using flow and bottom tracking velocity was applied. Initially, since no filter is applied yet, both Qraw and Qfilter are identical. However, Qfilter will be altered after applying filters later on, as the user will notice. The file pane will appear in every interface, so that the user can quickly explore filtering results by clicking the file name or using up and down on keyboard. If the user just clicks the ‘OK’ button without further customizing parameters of individual filters, the default filtering parameters will be automatically applied. If the user wants to skip applying a filter, ‘Cancel’ button should be clicked. The users are also allowed to deselect file(s) in the file pane by un-checking checkbox. And specific filters for all files can be selectable (see the bottom pane). For example, if the user deselects Error Velocity Filter, this filter will not be applied for any files, even though this filter was selected in the individual file filter setup.
6.1. Error velocity filter

Assuming that the error velocity has a Gaussian distribution, VMS computes the standard deviation of all error velocities in the transect, removes data outside a given time (4 as default) of the standard deviation, and repeats this process by using the remaining data until no additional data can be removed. The user is able to see this interface by clicking 'Error Velocity' tab above the chart, and the following interface will show up.
Whenever, this interface shows up, default or customized filtering parameters are automatically applied for a selected file (with blue color in the file pane), and the results are displayed in the chart, where the red colored dots are the filtered error velocity. The interface reports the number of bad bins originated from ASCII files where percent good is zero, and the number of bad bins after applying the velocity error filter, which additionally filters data that has -32678 as velocity error but percent good is 100. Therefore, although there are no red dots in the chart, the interface might report a number for the bad bins after applying the filter criteria. When the error velocity is filtered, other relevant velocity component such as eastern, northern, and vertical velocity will be changed as bad (-32678) data, and will not be used in computing discharge. Therefore, the data will be interpolated instead.

The filter criteria (minimum and maximum) is internally computed and reported, depending on the filter multiplier. The user can change this filter multiplier and click the ‘Apply’ button. Then the user will be able to see computed filter criteria, subsequently the number of bad bins...
from filter criteria, and red dots in the chart. If the user deselects the ‘Apply Error Velocity Filter for further processing’ checkbox, the filtered results will not be applied when the user finally clicks ‘Apply Filter’ in the bottom pane.

When the user explores files and chooses filter criteria, each customized filter setup will be saved in memory, and will be updated when the user returns to that same customized file. If the user goes back to the ‘Discharge Info’ tab after applying the velocity error filter, he will see the filtered discharge (Qfilter) in the table and chart is now changed.

6.2. Beam depths filter

The beam depths are filtered individually by smoothing with a moving window, and the window size depends on the data on both sides of the point being evaluated. This interface will be showed up as illustrated in Figure after the user clicks the ‘Beam Depths’ tab.
The interface for the beam depth filter reports filtered beam depth as displayed in the charts, which depends on filter parameters such as smoothing span, filter half width (smoothing window size), multiplier (criteria), and cycles (number of repeated filter algorithms). The red lines in the charts (Beam 1 ~4 Depth) indicate smoothed lines. When applying smoothing, zero depth is not included as part of the input dataset, and thus, is eliminated by default. The mean depth chart shows mean depth based upon raw and filtered beam depth by simple averaging, where zero depth is not included for calculating raw mean beam depth. Filtered mean depth only differs from raw mean depth when filtered beam depths exist where they were replaced with a corresponding smoothed beam depth. The results after applying this filter for discharge is not implemented yet, so the user cannot see how this filter affects discharge.
6.3. Boat speed filter

This filter uses an approach similar to beam depths, applying a smooth and a moving window with a window size dependent on surrounding data. Currently, boat speed based on the bottom tracking is applicable for this filter. Click ‘Boat Speed’ tab, and the user will see the following interface. The shaded area indicates a filter range which is reflected from the filter parameters.

![An interface for the boat speed filter](image)

Figure 6.6. An interface for the boat speed filter

6.4. Summary report

VMS provides a summary of the various filters for individual files. To see the summary report, click ‘Summary Report’ tab as described in Figure 6.8. Basically, the summary report provides filter information as shown in Table 6.1.
Figure 6.8. An interface for summary report

Table 6.1. Contents of the summary table of the filters

<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileName</td>
<td>File name of a given transect</td>
</tr>
<tr>
<td>VFilter_Applied</td>
<td>Whether the filter for the \textit{velocity error} was applied or not</td>
</tr>
<tr>
<td>VE_Filter_#Bad(raw)</td>
<td>The number of bad cells in the raw data (when percent good is zero)</td>
</tr>
<tr>
<td>VE_Filter_#Bad(filtered)</td>
<td>The number of filtered cells in terms of flow velocity</td>
</tr>
<tr>
<td>DepthFilter_Applied</td>
<td>Whether the filter for the \textit{depth} was applied or not</td>
</tr>
<tr>
<td>DepthFilter_#Bad</td>
<td>The number of filtered depths for all available beam depths</td>
</tr>
<tr>
<td>BoatFilter_Applied</td>
<td>Whether the filter for the \textit{boat speed} was applied or not</td>
</tr>
<tr>
<td>BoatFilter_#Bad</td>
<td>The number of filtered boat speeds</td>
</tr>
<tr>
<td>Filter_Appliance</td>
<td>Whether the filter for the \textit{FILE} was applied or not</td>
</tr>
<tr>
<td>File_Viewed</td>
<td>Whether the \textit{FILE} was viewed or not</td>
</tr>
<tr>
<td>Filter_Setting</td>
<td>Whether the default setting of filters was accepted or changed</td>
</tr>
</tbody>
</table>
6.5. Save and reload filter setup file

The customized filter setup is able to be saved and reloaded without the user having to recreate the filter setup. When the user loads a setup file, VMS compares file names in the file pane with file name in the reloaded setup file, and only updates the filter setup of existing files. If the file name is not in the setup file, VMS uses a default filter setup. Thus, the user has the ability to keep updating an archive of filter setups, which can be broadly used for the user group. However, the saving function is still not smart enough to do selective archiving, so the user will have to save the filter setups individually, and then manually combine them into a single ‘mater’ filter setup file.

![Figure 6.9. Save and reload filter setup](image)
7. Transect Information

VMS provides a graphical user interface which displays each transect, and allows the user to select a transect from a list. Once a transect is selected, and click the attached button ( ) or double-click a file, it can then be examined in more detail with other interfaces including graphic (color contour plot of velocities, vertical and horizontal view, animation, and ship track) or tabular displays. The graphical interface includes both 2-D and 3-D representations of the data.

Figure 7.1. Select a transect in the file pane and click attached button to examine details

7.1. Tabular view

Once the button is clicked, a new interface will show up including file name on the top of the window. The ‘Summary’ table in the ‘Tabular’ tab will be activated by default. This table
provides summarized information that is similar to summary file provided by WinRiver I.

Figure 7.2. Summary table for a transect

In particular, computation of the mean flow direction, flow speed, and cross-sectional area described in Figure 7.2 depends on user-defined options. Figure 7.3a shows how to change such options. For the determining mean flow direction, there are two options (see Figure 7.3b): simple numerical averaged of velocity component, and direction that minimizes cross-stream component. For calculating cross-sectional area, there are three options: parallel to mean transect path (line between start and ending point), along a user defined azimuth, and perpendicular to mean flow direction. Mean flow speed can be estimated by two options: simple numerical average of velocity component and discharge divided by cross-sectional area.
Figure 7.3. Options for cross-sectional computations: a) selection of menu; b) options for calculating mean flow direction; c) options for calculating cross-sectional area; d) options for calculating mean flow speed

Under the Tabular tab, there are two other subsets: All Ensembles (2D) and All Cells (3D) tables as illustrated in Figure 7.4 and 7.5, respectively. The All Ensembles (2D) table includes information recorded in the header part of each ensemble from an ASCII file, such as time, BT velocity, and latitude/longitude, as well as processed data, such as depth averaged velocity components. The All 3D Cells (3D) table includes information recorded in the body part an ensemble's corresponding ASCII file, such as velocity components at bins.
**Figure 7.4. All Ensembles (2D) table for a transect**

### 2D Information for each ensemble

<table>
<thead>
<tr>
<th>Ensemble</th>
<th>2D Information</th>
<th>Other Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A03</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A06</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A07</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A09</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A23</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A26</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A27</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**2D Ensemble Tab**
Figure 7.5. All Cells (3D) table for a transect

7.2. Contour plot

If the user clicks the Contour tab in the upper part of the interface, the colored contour plot for the velocity magnitude will show up (see Figure 7.6). At this time, only velocity magnitude is used, and does not include other parameters like velocity component/ intensity. Note that contour plot shows vertical averaged velocity magnitude for 1 ft or meter step.
7.3. Velocity profile

VMS provides two different types of velocity profiles: vertical and horizontal. First, the vertical profile at each ensemble can be examined in the Vertical tab. Along the ship track, the user is able to move forward or backward to see the velocity data in tabular and 3D graphical format. When the user starts the animation, a dynamic variation of the 3D velocity in the transect can be visualized. To rotate the chart in 3D the user should left-click and drag the cursor around inside the chart. In order to zoom in and out, click the “Edit Chart” button located to the right of the chart, and then select the 3D tab. Under this tab the zoom slider will be visible and allow for this manipulation.
Second, the horizontal profile can be represented as depth-averaged (Figure 7.8), nearest surface (Figure 7.9), nearest bottom (Figure 7.10), and layers (Figure 7.11).
Figure 7.8. Horizontal velocity profile – depth averaged
Figure 7.9. Horizontal velocity profile – nearest surface
Figure 7.10. Horizontal velocity profile – nearest bottom
Figure 7.11. Horizontal velocity profile – layer
7.4.  Ship track

If the user click ‘Ship Track’ tab, the following chart will show two different track of ADCP, based on bottom tracking and GPS.

Figure 7.12. ADCP track based on the bottom tracking and GPS
8. Spatial Averaging

In general, the users collect ADCP data in a single or multiple transects over the same cross section wanting to show horizontally and/or vertically averaged data in order to obtain the mean flow characteristic by filtering erroneous or extreme spikes of data, rather than displaying raw velocity data. From this regard, VMS supports horizontal averaging along transects with specified averaging step (or horizontal spacing). Usually, a single ADCP transect or grouped ADCP transects are not aligned along a straight line. Rather, ADCP transects are collected along the curvilinear path as illustrated in Figure 8.1. VMS has the capability to compute such a mean curvilinear paths based on a grouped transects. And for spatial averaging, the horizontal spacing of the averages will be then applied to generate evenly spaced points over the curvilinear mean path of the given transects, where the averaged velocity data will be calculated based on raw ADCP data that falls within a user defined searching area (diameter of circle) which is assigned. The depths along the mean path were interpolated by using Inversed Distance Weighted (IDW) method and then smoothed, and the depth at each evenly spaced point will be taken from adjacent depths based on these interpolated depths. The horizontal averaging can be conducted for both a single and multiple groups of transects.

For the spatial averaging, VMS support two main interfaces according to averaging for SINGLE or MULTIPLE groups. First interface (described in section 8.1), which is independent of the main interface, handles only one selected group of transects and shows very details of the averaged results, such as three-dimensional representation of the averaged results or grid-based averaging for validating numerical simulation. Second interface (described in section 8.2), which is the main interface, handles multiple groups of transects including grouping function. This interface visualizes only two-dimensional averaged velocity information, but support exporting the averaging data into ASCII or shape file format. Yet Google Earth format is not compatible with the results from the horizontal averaging.
8.1. Horizontal averaging of single group

As mentioned earlier, the section (8.1) will provide the horizontal averaging functions for only one group based on the selected transects. Keep in mind that VMS does not give reasonable results if the selected transects for making a group are not repeated transect.

8.1.1. Making a group using multiple transects

The starting point for performing horizontal averaging is to load the required ADCP data as illustrated as follows. As seen in Figure 8.1, ADCP transects were repeatedly measured for a given area, and total 4 groups can be formulated. In this section, one of groups will be selected but in section 8.2, all of the groups will be used in the horizontal averaging.

Figure 8.1. Load multiple ADCP files
The first step is to make a group based on the user-selected transects. Currently, only manual grouping is possible in VMS. In order to perform manual grouping the user will select transects from the side panel and indicate which group transects belong to (see yellow dots in the Figure 8.2).

![Image of VMS interface showing manual grouping of multiple transects](image)

**Figure 8.2. Manual grouping of multiple transects (see selected yellow dots)**

Second step is to open a new interface that provides various functions for the horizontal averaging in particular. Right click the mouse on the file pane, and select menu ‘Averaging Selected Files’ as illustrated in Figure 8.3. ‘Ctrl+A’ is the assigned short key of this function.
8.1.2. Setup of averaging parameters and run horizontal averaging

The user will see a new interface that includes options for horizontal averaging and displays the locations of the multiple ADCP files in the map (Figure 8.4). Initially, the interface will show ADCP locations and default options for the spatial averaging. As averaging options, ‘Averaging Step’ is used as curvilinear distance between evenly spaced points that will be used as positions for conducting spatial averaging. The value in the ‘Searching Radius’ option will be used as a radius of the circular searching area. ‘Side Lobe Percentile’ sets up the vertical lower limit for applying spatial averaging, meaning that some amount of the averaging data near the bottom should not be used by following the principle of ADCP that considers the side lobe interference to cut out the measured data near the bottom (usually 6~7 percent of bathymetry). The user can set this percentile (default is set as 10% of bathymetry). Finally, ‘Smoothing Span’ option is related with finding mean curvilinear path. The larger value will give more roughly smoothed
mean path. The user is able to process or reprocess the data for different purposes by changing options and averaging criteria without having to reselect the data files.

VMS supports an automated approach to horizontal averaging that could avoid averaging across changes in flow distribution (see ‘Apply Homogeneity Filter’ option in the parameter pane). This involves developing an algorithm to identify mean flow direction within the given search areas, where velocity vectors having less than a given angle criteria are used in horizontal averaging. This approach only considers the flow distributions that are reasonably homogeneous and ensure the averages do not cross automatically identified zone boundaries.
After setting up parameters for averaging, click the ‘Averaging’ button. The numerical and graphical outputs are able to be displayed when user click ‘2D View’, ‘3D View’, and ‘Vertical Avg’ tabs located in the bottom of the interface.

### 8.1.3. 2D visualization of the horizontal and depth averaged velocity

Once running horizontal averaging, the interface will display the mean path, evenly spaced points, and depth averaged velocity vector after calculating horizontal averaging. The table at the bottom of the interface displays the numeric values with the data in the graph.

For better visualization, the scale of velocity arrows can be changed as follows:

![Figure 8.5. Visualization of the averaged velocities](image-url)
In order to identify which data in the table corresponds to the chart, the user clicks a row of the table. A circled green symbol is then displayed on the chart for the current selected data point, which indicates the location of that point. In order to find a specific point, the user can just use the keyboard up or down arrows after selecting a row. The illustration below shows how this is done.
User can resize table or chart by clicking left button of mouse between table and chart, by dragging mouse up or down. Table 8.1 shows the detailed descriptions for the table in 2D View.

Table 8.1 Description of the header of 2D View

<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTM_E</td>
<td>Eastern value of UTM at the evenly spaced point</td>
</tr>
<tr>
<td>UTM_N</td>
<td>Northern value of UTM at the evenly spaced point</td>
</tr>
<tr>
<td>Bathymetry</td>
<td>Interpolated bathymetry at the evenly spaced point</td>
</tr>
<tr>
<td>DepAveV_E</td>
<td>Eastern component of the horizontal/depth averaged velocity</td>
</tr>
<tr>
<td>DepAveV_N</td>
<td>Northern component of the horizontal/depth averaged velocity</td>
</tr>
</tbody>
</table>
The random errors of velocity magnitude and direction are calculated and provided by using the following equations, and VMS regards random errors as the uncertainty, assuming that there are no systematic errors (or bias) in the velocity. As matter of fact, it can be said that the uncertainty represented herein is a simplified value, and its value will be at least bigger than it, depending on the range of the systematic errors.

\[
V_{\text{mag}}_{\text{uncertainty}} = 2 \sqrt{\frac{V_{\text{east}}^{2} + V_{\text{north}}^{2}}{N}}
\]

\[
V_{\text{dir}}_{\text{uncertainty}} = 2 \sqrt{\frac{V_{\text{dir}}^{2}}{N}}
\]

The spatial averaging interface supports displaying raw velocity data for each file and the searching radius from the given averaging option. This function will help the user to visually check out how many raw data (ensembles) were used to generate spatially averaged data. Click a button ( ) on the right action pane as described in Figure 8.8, then, subsequently, the raw velocity vectors of the transects will be displayed. Then click a line in the data table (as likely as blue area illustrated in Figure 8.8), then a green circle will show the location of that data as well as a circle used as the search area based on the user-defined searching radius. The user can turn off the raw information and searching area by clicking the button again.
Figure 8.8 Displaying raw velocity data used for the spatial averaged within a given searching area

8.1.4. 3D visualization of the horizontal velocity

If the user clicks the ‘3D View’ tab located in the bottom of the interface, the following 3D graph will show up to allow the detailed visualization of 3D velocity vectors. By holding the left mouse button over the chart and moving the cursor around, the user can manipulate the viewing angle to allow for a visual inspection of the vector field. As likely as ‘2D View’, the user is able to identify which data in the table corresponds to the chart. The user clicks a row of the table and arrows up or down, then the user will see a circled red symbol, which indicates the location of data in the 3D space. For the better visualizing purpose, the user can increase (Zoom In) or decrease (Zoom Out) the size of velocity arrows.
Figure 8.9. 3D visualization of the averaged velocities

The user can zoom in/out by using a built-in function of chart. Click the editing chart button in the right action pane, and rearrange zoom ratio in 3D tab as described below.
Figure 8.10. Zoom In/Out of ‘3D View’ using Chart Editor

The ‘3D View’ shows the horizontally averaged velocity vectors at each regular vertical point, which are depth-averaged again, resulting in the horizontal/depth averaged velocity vector in the previous ‘2D View’. The vertical positions are based on a given vertical spacing determined from that of the raw data, and they start from the first bin depth of the used ensembles, and end up at a new depth by considering side lobe effect, which is defined from user’s setting (e.g., 10% of depth from the channel bottom was not be included in the vertical points as illustrated in Figure 8.9). Therefore, if the transects used during spatial averaging have different vertical spacing (i.e., bin size) or first bin depth, VMS will not work in such cases. Spherical search volume, instead of search area, might be a doable alternative to cope with above problem, but is currently not adopted in VMS. Thus, spatial averaging at each vertical point is conducted only for horizontally distributed points (i.e., located at the identical depth) within a given searching area. If there is no data available within the searching area, velocity vector will be recorded as NODATA (i.e., -32768). Table 8.2 shows the detailed description of the table in the 3D View.
<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTM_E[m]</td>
<td>Eastern value of UTM at the evenly spaced point (always metric)</td>
</tr>
<tr>
<td>UTM_N[m]</td>
<td>Northern value of UTM at the evenly spaced point (always metric)</td>
</tr>
<tr>
<td>Depth</td>
<td>Depth from the water surface for the center of the cell (bin)</td>
</tr>
<tr>
<td>AveV_E</td>
<td>Eastern component of the horizontally averaged velocity</td>
</tr>
<tr>
<td>AveV_N</td>
<td>Northern component of the horizontally averaged velocity</td>
</tr>
<tr>
<td>AveV_mag</td>
<td>magnitude of the horizontally averaged velocity</td>
</tr>
<tr>
<td>AveV_dir</td>
<td>Direction (Earth coord.) of the horizontally averaged velocity [deg]</td>
</tr>
<tr>
<td>AveV_ut</td>
<td>Uncertainty of the magnitude for horizontally averaged velocity</td>
</tr>
<tr>
<td>AveVdir_ut</td>
<td>Uncertainty of the direction for horizontally averaged velocity [deg]</td>
</tr>
<tr>
<td>Used Ensembles</td>
<td>The number of used ensembles for horizontally averaged velocity</td>
</tr>
<tr>
<td>Search Radius</td>
<td>The radius of searching area</td>
</tr>
<tr>
<td>Homogeneity_check</td>
<td>Whether homogeneity filter is used or not</td>
</tr>
</tbody>
</table>

**8.1.5. Horizontal averaging along the single transect**

While VMS computes a mean curvilinear path for the group consisting of multiple transects, the horizontal averaging over a single transect (in other words, a group is equivalent to a transect) is conducted only along the given ADCP path (not finding mean path). Figure 8.11 displays this case.
8.1.6. Vertical averaging of horizontal averaged velocity

Vertical averaging will only be applied after horizontal averaging has been completed. This part was designed to allow the user to pull out horizontally averaged velocity data at a vertically specified location, such as depth-averaged, nearest surface, nearest bed, and a fixed/relative depth.

a. Depth averaged without accounting for unmeasured area

The unmeasured areas at the top and bottom of the profile, or at the edges of the stream, will not be accounted for in the depth averages. The horizontally averaged velocity data in the shaded area in the cross-section as illustrated below is used for the depth averages. The results
are displayed in the numeric and graphic format. Those results are able to be saved as a text file (CSV format, click ) or graphic format (go to chart editor by clicking , and select ‘Export’ tab and ‘Picture’ tab). A starting point of the cross-section (usually ‘0’) is also represented in the edge of the track with a yellow point and ‘0’.

Figure 8.12. Depth averaged without accounting for unmeasured area

b. Nearest surface

This layer will be the velocity in the upper most depth cell of each profile or averaged profile, independent of depth cell size and location (see red line in lower cross-section view as described in Figure 8.13).
c. **Nearest bed**

This layer will be the velocity in the lower most depth cell of each profile or averaged profile, independent of depth cell size and location.
Figure 8.14. Velocity distribution along the nearest bed

d. Layers

The averaging at a layer as a relative depth and layer size can be conducted. Relative depth and size allows the user to specify a layer (e.g., at 0.6*depth of profile from the surface). The layer size should always be a specified size and not relative. The shaded area (strip) in the cross-sectional view shows the horizontally averaged velocities within the shaded area. The user can arrange the size of the shaded area.
Figure 8.15. Velocity distribution along a specified vertical layer at a relative depth

The user is also able to retrieve data along a fixed depth. If the user selects ‘Fixed depth’ option instead of ‘Relative depth’, and set a number for the ‘Fixed Depth’ text box, then the following result will appear.
8.2. Averaging onto specified points (grids)

VMS also supports the ability to do averaging based on a user-supplied ASCII text file containing UTM points. This section is separate from the previous horizontal averaging conducted at the evenly spaced point along the mean curvilinear path, where the points are determined by the averaging step. Instead, this interface aims to support horizontal averaging onto user-specified points, such as the grids of the two-dimensional numerical simulation. Therefore, only searching radius is relevant to this process. In fact, grouping is not necessary for this sort of averaging, so any scattered ADCP measurements can be utilized in this processing. The user-specified points are read from a ASCII text file containing UTM points (x, y) and the format of ASCII file should have East/North locations with a extension of *.xy. Figure 8.17 describes the steps to read the user-specified points and the format of the ASCII file. VMS does not support to
make such an ASCII file, so the user should manually create it. The loaded UTM points will be displayed as green colored point. The horizontal averaging is then conducted at the given UTM points and results in two- and three-dimensional velocity data.

Figure 8.17. Loading of the user specified UTM points

Once the user sets the specific points and a searching radius, he can click the button located on the upper side of the ‘Point Avg’ interface. Figure 8.18 shows the results as numeric/graphic format. Note that ‘Averaging’ button in the left and lower corner will grey out, since this button only works for the evenly spaced points described in the previous sections.
Figure 8.18. Conduct averaging on the user specified UTM points

The results illustrated in Figure 8.18 are depth-averaged velocity data after the horizontal averaging. In order to see the actual horizontal averaging, click the button \[ \text{Compute averaged velocity button} \], then the following detailed three-dimensional description (see Figure 8.19) of the horizontally averaged velocity vectors will be seen. And the user can go back two-dimensional view by clicking the button \[ \text{Numeric output (2D)} \].
8.3. Horizontal averaging of multiple groups

Throughout section 7.1, the horizontal averaging has been conducted for a single group. However, such algorithms used for the horizontal averaging will also be able to be extended and applied for the multiple groups, when the given transects are grouped in more than one group. VMS supports the horizontal averaging for multiple groups as well, and the multiple grouping and their averaging takes place in the main interface instead of separate averaging interface used in section 7.1. The following figure 8.20 briefly explains several buttons associated with horizontal averaging in the main interface. While a button for the spatial averaging of the selected transects (i.e., a single group) was used in the previous section, other
buttons such as grouping, spatial averaging for the multiple groups, and clean the results of spatial averaging will be used for this section.

![Figure 8.20. Buttons relevant to horizontal averaging in the main interface](image)

**8.3.1. Making multiple groups**

The first step of the horizontal averaging for multiple groups is a manual grouping of the given transects. If the user clicks grouping button ( ), an interface for the group option will pop up. Before setting groups, the user is unable to use other buttons (they are currently grayed out as seen in Figure 8.20). The default option is to set a group for each transect as described in the Figure 8.21. After ‘Grouping of each single transect’ option is selected, group names (numerical number starting from 1 to the number of transects) will be automatically assigned for each transect, and displayed in the additional column of the left file pane. Without
any more settings, each individual transect will be in a different group, and horizontal averaging will be performed for each transect by following this default setting.

Figure 8.21. Default grouping of individual transect

However, when the user wants to group multiple transects into a distinct group, additional configuration is needed. Figure 8.22 describes how to manually group multiple transects, and name the group. First, select transects that fall in the specified area through the right file pane, and right-click of mouse to call popup menu then click ‘Grouping Selected Files’ or push ‘Ctrl-G’. The user is able to customize the group name from the ‘Set Group Number’ interface and click the ‘OK’ button. Finally, the group name in the left file pane will be changed as described below. Repeat this process for other multiple transects, and set groups individually. Figure 8.23 shows the fully grouped transects. If the user adds more transects after finishing grouping and running spatial averaging, an error message will show up to let the user set the
group name for ungrouped transects. Note that automatic grouping function based on the geospatial locations of transects is currently not available. So it should be also noted that the multiple transects are recommended to be grouped when they are within a given line or area, such as repeated transects measurements as seen in Figure 8.22.

Figure 8.22. Steps for grouping multiple transects
Figure 8.23. A sample of grouped transects

The above manual grouping process can be tedious if the user has to regroup every time whenever the user has to handle the same transects by opening VMS again. From this regard, VMS allows the user to save the pre-established grouping information, and reuse it for further analysis. Figure 8.24 demonstrates how to save group information by selecting the ‘Save customized groups’ option in the ‘Set Group Option’ interface. The group information will be saved with *.grp extension, which is actually CSV file format. Figure 8.25 shows an example of the saved group information.
Figure 8.24. Save grouping information
Figure 8.25. The saved grouped information

The saved file can be reloaded, where group name corresponding to transect name will be updated on the left file pane. As described in Figure 8.26a, when the user clicks the ‘Set Group Option’ button and chooses ‘Load the existing groups’, group names will be updated accordingly (see Figure 8.26b). Note that if the name of a certain transect in the left file pane does not match some of transects in the reloaded group info file, meaning that no pre-established group information exist about any particular transects, the user should manually assign a group name for those transects afterword (see Figure 8.22). Otherwise, spatial averaging will not work properly, and VMS will give an error message.
Figure 8.26. Loading the saved group information: a) how to load the saved group information; b) the loaded grouped information
8.3.2. Run horizontal averaging of the multiple groups

If the user completed grouping, the next step is to set averaging options (click button) such as averaging step, searching radius, side lobe percentile, and smoothing span. The above options are same as those used in the averaging interface for a single group. See the details in the previous section for more information. The configured averaging options are universally applied for multiple groups, which, in other words, mean that VMS does not support different averaging options for each individual group. After setting the averaging option, click the 'OK' button, and the spatial averaging for each group will be conducted, showing the averaged results in graphical and numerical format.

![Set Averaging Option](image)

Figure 8.27. Set averaging options for the group averaging

Figure 8.28 shows the graphical results, such as the depth averaged velocity vector and evenly spaced point with green color. The user can increase or decrease the size of velocity vector for the better display of the data. Note that the spatial averaging should be conducted only for the
Projected Coordinate System (either UTM 1983 or 1927). In the Geographical Coordinate System, the spatial averaging will not work properly.

Figure 8.28. Graphical display of the averaged velocity data

The velocity data displayed as the averaged results depend on the user-defined velocity representation type. The default velocity type is ‘depth-averaged velocity’, but if the user choose other types such as velocity nearest surface or nearest bottom, or a specified layer, the velocity vector will be shown accordingly. To test this feature, go to View → Velocity Representation, and select one of options as shown in Figure 8.29a, then the user will see the size of velocity arrow changes. In the bottom of the interface, the selected velocity type is shown as illustrated in Figure 8.29b.
Figure 8.29. Selection of the velocity type based on the averaged velocity data: a) menu option; b) information for the currently displayed velocity type.

The numerical result is also able to be displayed if the user clicks the ‘show data table’ button ( ) as described in the following Figure 8.29. The table contains group names, geographic location in the UTM coordinates, and depth-averaged velocity/nearst surface/nearst bottom/specified layer velocity data (depending on user’s selection as described above) with the computed random uncertainty. Note that the results for spatial averaging of the multiple groups are only displayed in the two-dimensional format \((u, v)\). In order to obtain three-dimensional format \((u, v, w)\), the user will have to save data as ASCII file (will be explained in the next section). In future, VMS will support three-dimensional display of the averaged results. The user can go back to the graphical display by clicking the icon ( ).
Figure 8.30. Numerical display of the group-averaged data

The user can see the raw data with the averaged data. Click ‘Spatial Layers’ table in the left-low of the interface, and check ‘Depth-averaged velocity (raw)’ layer. As a result, the following change will happen. The blue colored arrows indicate the raw depth-averaged velocity data, and green colored arrows are depth-averaged data after horizontal averaging.
Figure 8.31. Display of the raw depth-averaged velocity data with the averaged velocity data

If the user wants to apply another averaging options (e.g., different searching radius or averaging step), or go back to display only original raw data, it is recommended that the previous results of the spatial averaging should be cleaned. For this purpose, the VMS provides a ‘Clean Spatial Averaging’ button as illustrated in Figure 8.32.
When a group has a single transect, the spatial averaging process is much faster than one having multiple transects. This is because the spatial averaging over the single transect does not have to compute mean curvilinear path, bathymetry over the mean path, and bathymetry of the given evenly spaced points. Currently, the option for computing mean path is not available for a group having only a single transect. Figure 8.33 shows a typical type of ADCP measurements taken along the longitudinal direction of the river, and if the user want to apply spatial averaging for the individual transects, simply select the default ‘Set Group Option’ as ‘Grouping of each single transect’ (see Figure 8.33a), and conduct spatial averaging, which will lead to results in Figure 8.33b.
Figure 8.33. Group averaging for the groups where each group has one transect: a) grouping option; b) averaged results
8.3.3. Saving the averaged data

The grouped averaged results can be saved as ASCII format (CSV file) or GIS file format (shape file). Figure 8.34 shows how to save the results into these formats. In particular, the user can save three-dimensional averaged data (which were not displayed in VMS) as above formats. For exporting two-dimensional data such as depth-averaged and nearest surface velocity, choose ‘2D Spatial Avg’ menu. For exporting three-dimensional data, chose ‘3D Spatial Avg’ menu.

Figure 8.34. Exporting grouped averaged velocity data in 2D or 3D format: a) exporting as 2D or 3D GIS file format; b) exporting as 2D or 3D ASCII file format

Figure 8.35 shows the exported grouped-averaged velocity and bathymetry data displayed in the GPS package (ArcScene). Figure 8.35a describes three-dimensional geographical locations for conducting group averaging, and Figure 8.35b display the averaged velocity vectors, respectively. Figure 8.36 shows another example of the exported 3D GIS file, where four beam locations were added after spatial interpolation of the bed surface.
Figure 8.35. 3D GIS output from the group-averaged velocity data: a) 3D geographical locations for the averaging; b) 3D display of the averaged velocity vector
Figure 8.36. 3D GIS output from the group-averaged velocity data with interpolated bed surface:
a) 3D geographical locations for the averaging; b) 3D display of the averaged velocity vector